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Record Definition Files 

The grouper relies on a text file called a Record Definition File (RDF) to indicate the field 
position (column number) of each of the mandatory fields in the input file. The entries in the 
RDF act as a pointers so that the grouper knows the location of each mandatory field in the 
input file. Each time the grouper is run, the user must ensure that an appropriate RDF is 
selected. 

For convenience, the grouper installation includes sample RDFs; one for each of the data types 
that the application can process. These files can be found in the grouper installation folder. The 
grouper provides methods for creating user-defined RDFs (see below) but users may find that 
the sample RDFs provided with the application are sufficient for their needs. 

It is not necessary for the RDF to specify the positions of all the fields in the input file; only the 
mandatory fields must be specified. For a list of mandatory fields for each data type see the 
Guide to File Preparation document. 

Where the input file contains fields that are not specified in the RDF, the grouper simply ignores 
these fields during processing and passes them to the output file. The only reason to specify 
non-mandatory input fields in the RDF is where the grouper’s internal file viewer is used to view 
output files. The internal file viewer displays only those fields that are specified in the RDF. 

 
Grouping Modes 

The grouper offers three modes of operation: 

•  Non-interactive file grouping using the command line. 

•  Interactive file grouping using the graphical user interface. 

•  Interactive record grouping using the graphical user interface (single spell grouping) 

 

Running the Grouper from the Command Line (non-interactive mode) 

‘Command line’ refers to the non-graphical command shell user interface of Microsoft Windows. 
The Grouper can process a file using the command line and parameters shown below 
(mandatory parameters are enclosed within <angle brackets>; optional parameters are 
enclosed within [square brackets]): 

HRGGrouper -i<Input File> -o<Output File> -d<Record Definition File> -l<Grouping 
Logic> [-h] [-t] 
 
The command line parameters are: 

-i The path and filename of the input file. 
-o The path and filename of the output file.  
-d The path and filename of the record definition file. 



 
The Casemix Service 

HRG4 2010/11 Local Payment Grouper User Manual Page 4 of 39 
Author: The Casemix Service  

Copyright © 2010, The NHS Information Centre.  All rights reserved. 

-l The grouping logic (see below). This is the filename of one of the .tre files supplied as 
part of the grouper installation. 

-h Optional. Where present, indicates that the input file has a header row (field names). 
When absent, indicates that the first row in the file is a data row. 

-t Optional. Where present, turns off the generation of output file header rows (field names). 
If this parameter is omitted then each of the output files will contain a header row. 

Where there are spaces in paths or filenames, the parameter must be enclosed within 
double-quotes. 

The available Grouping Logic parameters are: 
 apc_v43lp Admitted Patient Care 
 nap_v43lp Non-Admitted Consultations 
 em_v43lp Emergency Medicine (HRG4) 
 ae_v43lp Accident and Emergency v3.2 (HRG v3.5) 
 acc_v43lp Adult Critical Care 
 ncc_v43lp Neonatal Critical Care 
 pcc_v43lp Paediatric Critical Care 

Note: for the local payment grouper, the grouping logic parameter names end in lp as an 
abbreviation for ‘Local Payment’; the penultimate character being the twelfth letter in the 
alphabet, not the numerical digit representing ‘one’. 

An example command line to run the grouper is shown below: 
HRGGrouper -i "C:\Grouper Testing\HRG4\500 Episodes\500 episodes.csv" 
-o "C:\Grouper Testing\HRG4\500 Episodes\output.csv" -d "C:\Program 
Files\IC\HRG4 2010_11 LP Grouper\HRG4_sample_APC.rdf" -l apc_v43lp -h 
–t 

 

Any messages generated by the application while running in command-line mode (e.g. 
validation issues, the number of records processed) are written to the HRG.LOG file in the 
grouper’s installation folder.  

A validation failure for the command line creates an entry in the HRG.LOG file. In addition, it 
causes a non-zero exit code to be returned. This means that a batch file or command file can 
check whether a command has passed validation by checking the value of %errorlevel%. 

Before running the command, the working directory must be set to the directory of the Grouper 
executable (HRGGrouper.exe). Use full path names for the input file, the output file and the 
record definition file where they are located in other directories. 

A sample batch file is shown below: 

C: 

cd "C:\Program Files\IC\HRG4 2010_11 LP Grouper" 
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HRGGrouper -i "C:\Grouper Testing\HRG4\500 Episodes\500 episodes.csv" 
-o "C:\Grouper Testing\HRG4\500 Episodes\output.csv" -d "C:\Program 
Files\IC\HRG4 2010_11 LP Grouper\HRG4_sample_APC.rdf" -l apc_v43lp -h 
-t 

Grouping in Interactive Mode 
Interactive mode uses the grouper’s graphical user interface. Start the grouper using the 
shortcut on the Windows Start menu. 

 
Steps to group a file 
1. Export data (e.g. from a Patient Administration System or other computer system) in 
comma-separated text format. It is strongly recommended that field names are included as 
the first row of the data extract; this makes it considerably easier to work with the file. The 
Guide to File Preparation document (available from the Casemix web site) specifies the input 
file mandatory fields and their formats. 
 
2. On the grouper main screen Current Database tab, select the Database that corresponds 
to the data type to be grouped. 

 
 

 

Click here 
to select 

database 

 
3. Select an appropriate Record Definition File (RDF) for the database to be used for 
grouping. This is done by clicking the [Browse…] button and navigating to the appropriate 
RDF. 
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Ensure that the RDF is intended for use with the same data type as the selected database 
(e.g. if the selected database is Admitted Patient Care, ensure that the RDF was designed for 
Admitted Patient Care data). Failure to ensure that the data type of the RDF and the 
database match will lead to grouping errors. 
If a suitable RDF does not already exist for the file being processed then the grouper can be 
used to edit an existing RDF or to create a new one. See the section on the Record Definition 
File Wizard below. 
 
4. From the [Tools] menu select [Process File…], this opens Process File dialog box.  
 
5. Select the input file (the data to be grouped) using the browse button (folder icon) next to 
the input file field. Check the [Input data has headings] check box if the input data includes 
field names in the first row. 
 
6. Select the name and location for the creation of the output file using the browse button 
(folder icon) next to the output file field. The output file is the file that will contain the grouped 
data. Check the [Output data has headings] checkbox if there is a requirement for all output 
files to include field names. 
 
7. When all selections have been made, click the [Process] button to produce the grouped 
output file. A progress bar is displayed. For certain data types, grouping is preceded by a data 
sorting phase; a separate progress bar is shown for sorting. 
 
When grouping is complete, the Process File dialog box will close and the application returns 
to the Main Screen. 
It is very important that the user examines the entries in the log area after grouping.  If 
grouping fails, this will be reported in the log area. 
Note that the output file is a text file and may therefore be opened using a variety of 
applications. 
To open the output file from within the application, see the Display File section later in this 
document. 
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The Grouper Main Screen 
The Main Screen has a main menu, a toolbar, a tabbed display and a log area. 
 
• Main Menu 

 
File 

New RDF  Opens the RDF Wizard. 
Open RDF Opens a selected RDF for editing or review within the tabbed display area. 
Save Saves a currently open RDF (only available when an RDF is being edited). 
Save As Saves a currently open RDF with the option to rename or change location 

(only available when an RDF is being edited). 
Exit Closes the application. 

 
Edit 

Insert Field Inserts a new line in an RDF for user-defined fields (only available when 
an RDF is being edited). 

Delete Field Deletes the currently selected user-defined field in an RDF (only available 
when an RDF is being edited). 

 
Tools 

Process File Opens the Process File dialog box. 
Display File Opens a selected file within the tabbed display area. 
Single Spell Opens the Single Spell Grouping screen. 
Run Reports Opens the Run Reports dialog box – note that reports are not 

available in the Local Payment Grouper. 
Select Database Opens the Database Selection dialog box. 

 
Help 

Index  Opens the user manual. 
Latest User Manual Opens a web page where the latest user manual can be opened or 

downloaded. 
About  Opens the About screen to display application version and contact 

information. 
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• Toolbar 

 
 

 New RDF  Opens the RDF Wizard. 

 Open RDF  Opens a selected RDF for editing or review within the tabbed 
display area. 

 Save  Saves a currently open RDF (only available when an RDF is 
being edited). 

 Insert Field  Inserts a new line in an RDF for user-defined fields (only 
available when an RDF is being edited). 

 Delete Field  Deletes the currently selected user-defined field in an RDF (only 
available when an RDF is being edited). 

 Process File  Opens the Process File window. 

 Run Reports  Opens the Run Reports box – note that reports are not available 
in the Local Payment Grouper. 

 Display File  Opens a selected file within the tabbed display area. 

 Single Spell Grouping Opens the Single Spell Grouping screen. 
 
• Tabbed Display Area 
This area shows screens that can be viewed by selecting the tabs at the bottom of the 
window when more than one of the following are open: 

•  Database Selection  
•  Record Definition File Editor  
•  File Display  

 
• Log Area 
This area displays progress and status messages during and after grouping. 
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Current Database 

 
 

The current database is shown on the main window of the application (see screenshot above). 

The user must ensure that the Database selected matches the data type of the Record 
Definition File and the type of data to be grouped. Failure to ensure that the data type of the 
RDF and the database match will lead to grouping errors. 

The Record Definition File drop-down box displays any Record Definition Files that have been 
used within the current session.  The [Browse] button allows the user to locate Record Definition 
Files. 
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Record Definition File Wizard 

A Record Definition File (RDF) is required by the Grouper to identify the locations of the fields in 
the source data.  The Record Definition File Wizard allows the user to create a Record 
Definition File. 

The Record Definition File Wizard is accessed via the ‘New RDF’ item on the ‘File’ menu. 

Using the Record Definition File Wizard: Step One 
Note that sample Record Definition Files are provided as part of the grouper installation 
program; these can be found within the grouper program folder. User-defined RDFs allow 
users the flexibility of using the grouper with locally-defined input file layouts. 

 

 
 

The mandatory fields required in the RDF are different for each database. 

The [Create fields manually] option allows the user to use a grid to define field positions and 
attributes.  To jump straight to the RDF editor, select this option and click the [Next] button. 

The [Create from a sample file] option allows the user to create an RDF interactively using a 
sample data file.  Clicking [Next] will prompt the user to select the file on which the RDF is to be 
based. 
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Using the Record Definition File Wizard: Step Two 

Where the user selects [Create from a sample file] from the dialog box described in Step 
One, the user is prompted to browse for the file, after which the dialog box shown below is 
displayed: 
 

 

Preview 
area 

 
The first row of the data file is displayed in the lower part of the dialog box (the preview area), 
above it temporary field names (‘Field 1’ etc.) are shown. 

The preview area automatically assigns field positions based on the comma positions in the file. 

For Admitted Patient Care, the [Number of diagnosis codes] and [Number of procedure 
codes] values may be edited to allow the processing of files that contain a non-standard 
number of clinical codes. Other data types allow similar changes to the numbers of specific 
fields; see Guide to File Preparation for details. 

All entries in the Mandatory Fields list must be assigned to fields in the sample file.  Fields are 
assigned by dragging the name from the list to the appropriate field in the preview area.  Fields 
appear in the Assigned Fields list as they are used.  The screenshot below shows the process 
partially completed (some fields assigned). 
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Multiple fields can be selected using the SHIFT and CTRL keys in combination with mouse 
clicks.  The selected collection of fields can then be dragged to the preview area. 

To remove an assigned field, select it in the Assigned Fields list and press the Delete key.  The 
field will be returned to the bottom of the Mandatory Fields list (not its original position). 

When all fields have been assigned, click [OK] to proceed. The RDF will be opened in the RDF 
editor, allowing checking and any required amendments. 
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Record Definition File Editor 

 
 

The RDF Editor provides a manual method of assigning field positions and attributes. 
 
Field Name Field abbreviation. This is for internal use and cannot be changed. 
Field Title Field description - can be edited by the user to show a meaningful name for 

the field. 
Field No The field position in a comma-separated input file, with the first field being 

number one. 
Picture Allows the user to provide filtering instructions to the Grouper by describing 

a ‘Picture’ of the field.  During the processing the Grouper will apply this 
picture to the field and only use the specified characters. See the section 
‘Picture’ later in this document. 

Extract Allows the user to provide filtering instructions to the Grouper by describing 
an ‘Extract’ instruction.  During processing the Grouper will apply this Extract 
instruction to the field and only the characters that the user has specified.  
See the section ‘Extract’ later in this document. 

 
The [Insert] toolbar button inserts a new field in the RDF. This feature is provided so that 
non-mandatory fields can be shown using the ‘Display File’ feature. It is not necessary for the 
RDF to specify the positions of all the fields in the input file; only the mandatory fields need to be 
specified. 

The [Delete] toolbar button removes a field from the RDF. Mandatory fields cannot be deleted. 
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When the RDF is saved the user will be informed if any validation checks (such as conflicting 
field positions) have been failed.  These issues must be resolved before the file can be saved. 
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Process File 
From the [Tools] menu select [Process File…], this opens Process File dialog box. Select 
the input file (data file) using the browse button (folder icon) next to the input file field.  
Note that with the default setting of 'Input files' selected in the 'Files of type' list, the 'Open' 
dialog box accessed via the browse button will list files with '.csv' and '.txt' extensions only. 
Change this value to ‘All Files’ if the input file has a different extension. 
Check the [Input data has headings] check box if the input data includes field names in the 
first row. 
Select the name and location of the output files using the browse button (folder icon) next to 
the output file field. The output files are the files that will contain the grouped data. The output 
files will be named using the name that the user enters as a file name prefix; the grouper 
appends a special file name suffix to each output file. See the Appendix for further 
information. 
Check the [Output data has headings] check box if the output files are required to include 
field names in the first row. 

 

 

Browse 
buttons 

 
When all selections have been made, click the [Process] button to group the file.  A progress 
bar is displayed. 
When grouping is complete, the progress bar and the Process File dialog box will close; the 
application returns to the Main Screen. 
It is very important that the user examines the entries in the log area after grouping.  If 
grouping fails, this will be reported in the log area. 
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Display File 

The application provides a ‘Display File’ facility, accessed from the ‘Tools’ menu, this file viewer 
can be used to examine grouper output files. The fields displayed using this facility are restricted 
to those defined in the Record Definition File. The field positions, pictures and extract values 
from the RDF are applied. 

Note that the output files are comma-separated text files so can be opened using other 
applications (e.g. Microsoft Excel). 

 
 

Double-clicking on a record within the display opens it in the Single Spell Grouping screen. 
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The space beneath each field name allow the user to enter filter criteria to limit the records 
displayed based on one or more starting characters.  Pressing the Enter key activates the filter.  

The screenshot below shows the display file feature with an active filter:  

 
 

Multiple criteria can be added by entering values in more than one column. 

To remove a filter criterion, delete it and press the Enter key.
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Single Spell Grouping 

This option allows real-time grouping of individual records using data manually entered by the 
user. The mandatory fields for the currently selected database are displayed within the upper 
area. Default values are entered automatically when the single spell grouping window opens. 

The user can edit or insert data by typing into the Value column. Pressing the Enter key displays 
the code’s description where a valid code has been entered. A valid record definition file must 
be selected in order to use single spell grouping. 

The single spell grouping dialog box is shown below: 

 
 
Clicking the [Click To Add Episode] header bar will open an adjacent set of columns 
allowing values for a second episode to be entered and grouped as part of the same spell. 
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Clicking the [Group] button will process the values entered and will display the HRG and 
other derived information in the output (lower) area. 
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Database Selection Screen 
From the [Tools] menu, select [Select Database…] to open the dialog box shown below: 
 

 
 

This dialog box provides both an alternative mechanism for selecting the current database and 
a way of exporting database tables. 

The Table drop-down box displays a list of data files that make up the currently chosen 
database.  Selecting one will show a brief description of it in the accompanying area. 

Clicking [Select] will set the Grouper to use the selected database. 

Clicking the [Export] button will export the selected table, the user being prompted for a filename 
and location. 
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Reports 

Unlike the Reference Cost Grouper, the Local Payment Grouper does not produce any reports. 

Reporting buttons and screens are visible in the Local Payment Grouper application but are not 
functional.
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Subtraction of Days from Admitted Patient Care Duration 

The Grouper facilitates the subtraction of days for Critical Care from finished Consultant 
Episode and Hospital Provider Spell durations. 

Where the user populates the input data fields with numbers representing the appropriate days 
of activity, these will be used by the grouper to calculate modified output fields. 

Although the field is mandatory in the input data (i.e. the column must exist in the file) it may be 
left blank or populated with zeros. This could be appropriate where either there are no days to 
be removed or the relevant days have been removed from the input data prior to grouping. 

For further guidance on using this facility, please see the document ‘Guide to File Preparation’ 
which is available from the Casemix website. 
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Picture 

Picture is a feature of the record definition file that can be used to specify the inclusion or 
exclusion of specific character positions from input fields. 
 

  

Picture 

Picture allows the user to provide filtering instructions for each field by describing a character 
template. During file processing the application will apply this template to the field by selectively 
ignoring characters in specific positions within a data field.  

An “A” character indicates a character position to be included in grouping and a full-stop 
indicates a character position to be ignored in grouping. The picture will be imposed on the data 
field prior to grouping i.e. the grouping algorithm is provided with the modified version of the field 
contents. 

To use Picture, enter a character template in the ‘Picture’ column of the Record Definition File 
(RDF) using the grouper’s built-in RDF editor (accessed via the ‘File’, ‘Open RDF…’ menu 
item). 

Notes: 

• The characters in Picture should not be separated by spaces. 

• Quote-marks should not be included. 

• Picture can be used with alpha and numeric fields. 

• Where the number of characters in the field exceeds the number of characters specified 
in Picture, the application will implement the Picture on the left-most portion of the field. 
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For this reason, care should be taken when using Picture with variable length fields as 
this may lead to unpredictable results. 

Picture Field Examples 
In the examples below, the characters are shown surrounded by double-quotes for clarity. The 
data entered in the Picture column should not include double-quotes 

Example 1 

Entering a Picture of “AAA.AA” instructs the Grouper that the first three and the fifth and sixth 
characters of the field should be used. The fourth character is ignored. 

Example 2 

Entering a Picture of “.A.AAA” instructs the Grouper that the second character and characters 
four, five and six should be used; the first and third characters should be ignored. 

Example 3 

Entering a Picture of “.A.” indicates that the Grouper should use the second character only and 
ignore the first and third characters. 

Example 4 

Entering a Picture of “AA” indicates that the application should use only the first two characters 
in the field. Note that full stops are not required if consecutive characters from the beginning of 
the field are the only characters required. 
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Extract 
Extract is a feature of the record definition file that can be used to inform the grouper to ignore 
certain characters from input fields. 
 

 

Extract 

To use Extract, enter the character string to be removed in the ‘Extract’ column of the Record 
Definition File (RDF) using the grouper’s built-in RDF editor (accessed via the ‘File’, ‘Open 
RDF…’ menu item). 

Because the grouper input files are comma-separated, it is not possible to extract the comma 
character using this facility. 

More than one character can be entered in the Extract column. This informs the application that 
any occurrence of any of these characters in that field should be ignored in grouping. The 
application does not consider a series of characters as a string of characters to be ignored as a 
unit; each character entered is ignored wherever it appears in the input field. 

Notes: 

• The characters specified will be ignored wherever they appear in the input data field.  

• There is no relationship between the position of the character in the extract field and the 
position of the characters in the input field.  

• All occurrences of the characters are affected. 
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Extract Field Examples 
In the examples below, the characters are shown surrounded by double-quotes for clarity. The 
data entered in the Extract column should not include double-quotes unless it is intended that 
double-quotes are ignored in grouping.  

Example 1 

Entering an Extract character of “.” informs the application that all occurrences of the full-stop 
should be ignored when processing that field.  This is a convenient way to remove decimal 
points from a field in the input file. An input field containing the character string “abc…d” will be 
interpreted by the application as “abcd”. 

 
Example 2 

Entering the characters “+$” in this field informs the application that any occurrences of both the 
“+” character and the “$” character are to be ignored by the application when processing that 
field. An input field containing the character string “46+$$++” will be interpreted by the 
application as “46”. 
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 Contact Information 
This software and associated materials are the Copyright © of the NHS Information Centre. 
 

Help is available for both technical and general queries from the NHS Information Centre 
contact centre: 
 

Telephone: 0845 300 6016 (Monday – Friday, 9am - 5pm) 
Email: enquiries@ic.nhs.uk 
www.ic.nhs.uk/casemix 

 

http://www.ic.nhs.uk/casemix
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Appendix 

Output Files 

The output files aim to meet the needs of those familiar with relational data as well as those who 
require non-relational files. Specific relational outputs include “_rel” as a part of the output 
filename. 

Generally, a single input file produces a number of output files. User requirements determine 
which files are used; some users may not require certain output files. In most cases an output 
field appears in more than one file. In the text below, the file name supplied by the user during 
processing is referred to as [name]. 

Use of ‘RowNo’ and ‘Iteration’ Fields 

The role of the ‘RowNo’ field is to provide a method of uniquely identifying FCEs within output 
files. The existence of a unique identifier for FCEs allows related records to be identified in 
different output files. 

For example, in the case of unbundled HRGs, the file [name]_ub_rel.csv shows the unbundled 
HRGs for each output row. The field ‘RowNo’ contains the ‘RowNo’ of the matching output 
record in the file [name]_FCE.csv. If these files are imported to a relational database, the 
‘RowNo’ fields can be used as the basis from which to derive keys to allow the relationship 
between these records to be represented. 

Where there is more than one related record, for example where there are more than one 
unbundled HRGs for an FCE, the field ‘Iteration’ is used to differentiate between the multiple 
related records.  

Examples of where ‘Iteration’ is used are: 

•  an input row may generate more than one unbundled HRG 

•  an input row may result in more than one data quality message 

There is no significance to the numerical values of ‘Iteration’, the numbers are assigned in order 
according to the order of the input data (the sorted input data in the case of files that are sorted 
prior to grouping). 

Admitted Patient Care 

A single input file produces eleven output files. 
  
1. File  [name].csv A list of other output files; this file is for validation only and 

will normally be ignored by users. 
 
2. File  [name]_sort.csv This a copy of the input data after it has been sorted into 

Provider Code, Spell Number and Episode Number order 
prior to grouping.  It also contains a unique row number 
added as a final column assigned after the sorting process.  
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This row number is intended to be used as the key when 
using relational data.  

 
3. File  [name]_FCE.csv This file contains both FCE and spell output fields. The spell 

fields are repeated for each episode in the spell; beware of 
double-counting when using spell fields. The file structure is 
as follows: 

<input data> All of the input data for the FCE, including any non-
mandatory fields are reproduced in the output. 

RowNo. The row number field mentioned in the “sort” file.  It is 
unique within the file. 

FCE_HRG. The episode level Core HRG. 
GroupingMethodFlag An indication of the grouping method used for the episode.  

“P”=Procedure driven, “D”=Diagnosis driven, “M”=Multiple 
trauma. 

DominantProcedure The dominant procedure used for procedure based 
grouping. 

FCE_PBC Programme Budgeting Category. This field is populated in 
reference cost groupers only. 

CalcEpidur The calculated episode duration.  This is the input Episode 
duration minus the number of critical care days entered. 

ReportingEpidur The episode duration used when generating reports. This 
field is populated in reference cost groupers only. 

FCETrimpoint The episode trimpoint for the HRG allocated to the episode. 
This field is populated in reference cost groupers only. 

FCEExcessBeddays The number of days that the episode exceeds the trimpoint. 
This field is populated in reference cost groupers only. 

SpellReportFlag Used when generating reports from grouped data. This field 
is populated in reference cost groupers only. 

SpellHRG The spell level Core HRG. 
SpellGroupingMethodFlag An indication of the grouping method used for the episode.  

“P”=Procedure driven, “D”=Diagnosis driven, “M”=Multiple 
trauma. 

SpellDominantProcedure DominantProcedure at spell level. 
SpellPDiag The primary diagnosis used when spell grouping. 
SpellSDiag The 1st secondary diagnosis used when spell grouping. 
SpellEpisodeCount The number of episodes in the spell 
SpellLoS The duration of the spell used for grouping 
ReportingSpellLoS The length of stay used when generating reports. This field 

is populated in reference cost groupers only. 
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SpellTrimpoint The trimpoint for the HRG allocated to the spell. This field is 
populated in reference cost groupers only. 

SpellExcessBeddays The number of days the spell exceeds the trimpoint. This 
field is populated in reference cost groupers only. 

SpellCCDays The number of critical care days in the spell. 
UnbundledHRGs A variable number of fields containing unbundled HRGs (at 

episode level).  
Unbundled HRGs are appended to the end of each record; 
there may be zero, one or more unbundled HRGs per 
record. 
For Specialist Palliative Care and Rehabilitation unbundled 
HRGs, where there is more than one daily HRG, the field 
consists of an HRG, followed by an asterisk, followed by the 
number of days, rather than the HRG repeated for every 
day. E.g. VC18Z*20 indicates VC18Z for 20 days. 
 

4. File  [name]_spell.csv This file can be considered semi-relational.  It contains one 
row per spell.  However, it also contains all of the 
Specialised Service Codes (SSCs) generated for the spell 
in a flat structure like unbundled HRGs in the FCE output. 
The FCE input data is not reproduced.   

RowNo Refers to the first row number in the sort or FCE output and 
will always be the first episode in the spell after sorting. 

 Unless all spells in the input data each consist of a single 
episode, RowNo in the spell file is not continuous (i.e. some 
numbers are absent). 

Procodet The organisation code from the user’s input file. 
ProvSpNo The hospital provider spell number from the user’s input file. 
SpellHRG The spell level Core HRG.  The first of the spell level output.   

Be careful to avoid double-counting when using spell level 
fields. 

SpellGroupingMethodFlag An indication of the grouping method used for the episode.  
“P”=Procedure driven, “D”=Diagnosis driven, “M”=Multiple 
trauma. 

SpellDominantProcedure DominantProcedure at spell level. 
SpellPDiag The primary diagnosis used for spell grouping. 
SpellSDiag The 1st secondary diagnosis used for spell grouping. 
SpellEpisodeCount The number of episodes in the spell 
SpellLoS The duration of the spell used for grouping 
ReportingSpellLoS The length of stay used when generating reports. This field 

is populated in reference cost groupers only. 
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SpellTrimpoint The trimpoint for the HRG allocated to the spell. This field is 
populated in reference cost groupers only. 

SpellExcessBeddays The number of days the spell exceeds the trimpoint. This 
field is populated in reference cost groupers only. 

SpellCCDays The number of critical care days in the spell. 
SpellSSC1 The first candidate SSC produced for the spell.  The 

grouper does not check eligibility.  All SSCs possible are 
output, for organisational SSC eligibility, check DH 
guidance. 

SpellSSC2 The second candidate SSC produced for the spell.   
…  
SpellSSC10 The tenth candidate SSC produced for the spell.   
UnbundledHRGs An aggregate of all unbundled HRGs produced for episodes 

in the spell. 
 
5. File  [name]_quality.csv Contains a row for each episode that contains an error. 

Where one or more episodes within a multi-episode spell 
contain errors, all the episodes from the spell, including 
those that do not contain errors, are included in the quality 
file. Thus there are records in the quality file that do not 
include error messages. 

 
<input data> All of the input data for the FCE, including any non-

mandatory fields are reproduced in the output. 
RowNo The row number field included in the ‘sort’ file; it is unique 

within the file. 
Error Message A variable number of fields containing the error message.  

Each message is the three fields shown in the relational 
quality file separated by pipe ( | ) symbols.  

 
6. File  [name]_FCE_rel.csv This file contains the FCE level output in relational form.   
 

RowNo The row number field mentioned in the “sort” file.  It is 
unique within this file. 

FCE_HRG The episode level Core HRG. 
GroupingMethodFlag An indication of the grouping method used for the episode.  

“P”=Procedure driven, “D”=Diagnosis driven, “M”=Multiple 
trauma. 

DominantProcedure The dominant procedure used for procedure based 
grouping. 
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FCE_PBC Programme Budgeting Category. This field is populated in 
reference cost groupers only. 

CalcEpidur The calculated episode duration.  This is the input Episode 
duration minus the number of critical care days entered. 

ReportingEpidur The episode duration used when generating reports. This 
field is populated in reference cost groupers only. 

FCETrimpoint The episode trimpoint for the HRG allocated to the episode. 
This field is populated in reference cost groupers only. 

FCEExcessBeddays The number of days that the episode exceeds the trimpoint. 
This field is populated in reference cost groupers only. 

SpellReportFlag Used when generating reports from grouped data. This field 
is populated in reference cost groupers only. 

 
7. File  [name]_spell_rel.csv Contains the Spell level output in relational form.  There is 

one row per spell. 
 

RowNo The key into other files. 
Procodet The organisation code from the user’s input file. 
ProvSpNo The hospital provider spell number from the user’s input file 
SpellHRG The spell level Core HRG.  The first of the spell level output.   

Be careful to avoid double-counting when using spell level 
fields. 

SpellGroupingMethodFlag An indication of the grouping method used for the episode.  
“P”=Procedure driven, “D”=Diagnosis driven, “M”=Multiple 
trauma. 

SpellDominantProcedure DominantProcedure, but at spell level. 
SpellPDiag The primary diagnosis used when spell grouping. 
SpellSDiag The 1st secondary diagnosis used when spell grouping. 
SpellEpisodeCount The number of episodes in the spell 
SpellLoS The duration of the spell used for grouping 
ReportingSpellLoS The length of stay used when generating reports. This field 

is populated in reference cost groupers only. 
SpellTrimpoint The trimpoint for the HRG allocated to the spell. This field is 

populated in reference cost groupers only. 
SpellExcessBeddays The number of days the spell exceeds the trimpoint. This 

field is populated in reference cost groupers only. 
SpellCCDays The number of critical care days in the spell. 
 

8. File  [name]_quality_rel.csv Includes a row for each episode that contains an error, in 
relational form. 
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RowNo The key into other files. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
Code Type The field type causing the problem. 
Code Where populated, the value of that code causing the 

problem. 
Error Message Explanation of the problem. 

 
9. File  [name]_ssc_rel.csv Contains the Specialised Service Codes.  There will be no 

entries for Spells that do not have SSCs. 
 

RowNo The key into other files.  In this case it is the row number 
associated to the spell/first episode in the spell. 

Procodet The organisation code from the user’s input file. 
ProvSpNo The hospital provider spell number from the user’s input file 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
SpellSSC The SSC derived for the parent spell 

 
10. File  [name]_ub_rel.csv The unbundled HRGs produced during the run.  There will 

be no entries for episodes that do not have any unbundled 
HRGs. 

 
RowNo The key into other files.  In this case it will be the row 

number associated to the episode in the spell. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
UnbundledHRGs The unbundled HRG 

 
11. File  [name]_summary.csv A single-row file containing details about the grouping run: 
 

Grouper Version The version of the grouper that produced the run. 
Database Version The internal HRG database version incorporated in the 

grouper. 
FCE Count The number of episodes submitted to the run. 
Spell Count The number of spells submitted to the run. 
FCE Error Count The number of episodes with errors. 
Spell Error Count The number of spells with errors. 
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Run Start Date/Time The data/time that the run started. 
Run End Date/Time The data/time that the run finished. 
Input Filename The path and filename of the input file. 
Output Filename The path and filename of the first output file mentioned 

above. 
RDF path and name The path and filename of the rdf file used in the run. 
 

Non-Admitted Care 

A single input file produces seven output files. 
 
1. File  [name].csv Contains a list of all the other files produced.  This file will 

normally be ignored. 
 
2. File  [name]_attend.csv 

 
<input data> All of the input data for the attendance, including any non-

mandatory fields are reproduced in the output. 
RowNo. A unique row number field applied when grouping.  This 

serves as the key for other output files. 
NAC_HRG The Core HRG for the attendance. 
GroupingMethodFlag An indication of the grouping method used for the 

attendance. 
DominantProcedure The dominant procedure used for procedure based 

grouping. 
UnbundledHRGs A variable number of fields containing unbundled HRGs (at 

episode level).  
Unbundled HRGs are appended to the end of each record; 
there may be zero, one or more unbundled HRGs per 
record.  

 
3. File  [name]_quality.csv This file contains one row per attendance that contain 

errors.  
 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 

RowNo The row number field mentioned in the attend file.  It is 
unique within the file. 

Error Message A variable number of fields containing the error message.  
Each message is the three fields shown in the relational 
quality file separated by pipe ( | ) symbols.  
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4. File  [name]_attend_rel.csv   

 
<input data> All of the input data for the attendance, including any non-

mandatory fields are reproduced in the output. 
RowNo A unique row number field applied when grouping.  This 

serves as the key for other output files. 
NAC_HRG The Core HRG for the attendance. 
GroupingMethodFlag An indication of the grouping method used for the 

attendance. 
DominantProcedure The dominant procedure used for procedure based 

grouping. 
 

5. File  [name]_quality_rel.csv All of the error messages in relational form.  There are no 
entries for attendances that do not contain errors. 

 
RowNo The key into other files. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
Code Type The field type causing the problem. 
Code Where populated, the value of that code causing the 

problem. 
Error Message Explanation of the problem. 
 

6. File  [name]_ub_rel.csv The unbundled HRGs produced during the run.  There are 
no entries for attendances that do not have unbundled 
HRGs. 

 
RowNo. The key into other files.   
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
UnbundledHRG The unbundled HRG 
 

7. File  [name]_summary.csv A sinlge-row file containing details about the grouping run: 
 

Grouper Version The version of the grouper that produced the run. 
Database Version The internal HRG database version incorporated in the 

grouper. 
Attendance Count The number of attendances submitted to the run. 
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Attendance Error Count The number of attendances with errors. 
Run Start Date/Time The date/time that the run started. 
Run End Date/Time The date/time that the run finished. 
Input Filename The path and filename of the input file. 
Output Filename The path and filename of the first output file mentioned 

above. 
RDF path and name The path and filename of the rdf file used in the run. 

 
Emergency Medicine 

A single input file produces five output files. 
  
1. File  [name].csv   Contains a list of all the other files produced.  This file will 

normally be ignored. 
 
2. File  [name]_attend.csv This is sometimes known as the attendance flat output.  Its 

structure is as follows: 
 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 

RowNo A unique row number field applied when grouping.  This 
serves as the key for other output files. 

EM_HRG The Core HRG for the attendance. 
 
3. File  [name]_quality.csv Contains a row for each input record that has errors. 
 

<input data> All of the input data for the attendance, including any non-
mandatory fields are reproduced in the output. 

RowNo The row number field mentioned in the attend file.  It is 
unique within the file. 

Error Message A variable number of fields containing the error message.  
Each message is the three fields shown in the relational 
quality file separated by pipe ( | ) symbols.  

 
4. File  [name]_quality_rel.csv All of the error messages in relational form. There are no 

entries for records that do not contain errors. 
 

RowNo The key into other files. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
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Code Type The field type causing the problem. 
Code Where populated, the value of that code causing the 

problem. 
Error Message Explanation of the problem. 

 
5. File  [name]_summary.csv A single-row file containing details about the grouping run. 
 

Grouper Version The version of the grouper that produced the run. 
Database Version The internal HRG database version incorporated in the 

grouper. 
Attendance Count The number of attendances submitted to the run. 
Attendance Error Count The number of attendances with errors. 
Run Start Date/Time The date/time that the run started. 
Run End Date/Time The date/time that the run finished. 
Input Filename The path and filename of the input file. 
Output Filename The path and filename of the first output file mentioned 

above. 
RDF path and name The path and filename of the rdf file used in the run. 

 
Adult Critical Care 

A single input file produces five output files. 
  
1. File  [name].csv Contains a list of all the other files produced.  This file will 

normally be ignored. 
 
2. File  [name]_acc.csv 

 
<input data> All of the input data for the attendance, including any non-

mandatory fields are reproduced in the output. 
RowNo A unique row number field applied when grouping.  This 

serves as the key for other output files. 
ACC_HRG The unbundled HRG for the ACC period.  All ACC HRGs 

are unbundled. 
Calc_CC_Days The number of CC days derived from the start and end 

dates entered.  This will be -1 if there are problems with the 
dates. 

CC_Warning_Flag Set to F, for Fail, if Calc_CC_Days is -1 or any of the 
checks mentioned below have failed.  This is not a part of 
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the “cruel” input validation.  A single data row can fail here 
but also have a valid (non U group) HRG. 

 
Validation Checks 
Calc_CC_Days = CC Discharge date - CC Start Date + 1 
Set warning flag if: 
Calc_CC_Days = -1; or 
CCL2 Days + CCL3 Days > Calc_CC_Days; or 
ARSD + BRSD > Calc_CC_Days; or 
ARSD + BRSD > CCL2 Days + CCL3 Days 

 
3. File  [name]_quality.csv Contains one row for each record that contains errors. 

 
<input data> All of the input data for the record, including any non-

mandatory fields are reproduced in the output. 
RowNo The row number field mentioned in the acc file.  It is unique 

within the file. 
Error Message A variable number of fields containing the error message.  

Each message is the three fields shown in the relational 
quality file separated by pipe ( | ) symbols.  

 
4. File  [name]_quality_rel.csv All of the error messages in relational form. There are no 

entries for records that do not contain errors. 
 
RowNo The key into other files. 
Iteration In conjunction with RowNo, provides a unique key for the 

record. 
Code Type The field type causing the problem. 
Code Where populated, the value of that code causing the 

problem. 
Error Message Explanation of the problem. 

 
5. File  [name]_summary.csv A single-row file containing details about the grouping run: 

 
Grouper Version The version of the grouper that produced the run. 
ACC Record Count The number of attendances submitted to the run. 
ACC Record Error Count The number of attendances with errors. 
Run Start Date/Time The date/time that the run started. 
Run End Date/Time The date/time that the run finished. 
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Input Filename The path and filename of the input file. 
Output Filename The path and filename of the first output file mentioned 

above. 
RDF path and name The path and filename of the rdf file used in the run. 

 
Neonatal Critical Care 

There are six output files. 
1. File  [name].csv  A single-row file containing details about the grouping run. 
2. File  [name]_ncc.csv  The main grouped output file. 
3. File  [name]_quality.csv  Contains one row for each record that has errors. 
4. File  [name]_quality_rel.csv  All of the error messages in relational form. 
5. File  [name]_sort.csv  A copy of the input data after it has been sorted. 
6. File  [name]_summary.csv  A single-row file containing details about the grouping run. 

 
 

Paediatric Critical Care 

There are six output files. 
1. File  [name].csv  A single-row file containing details about the grouping run. 
2. File  [name]_pcc.csv  The main grouped output file. 
3. File  [name]_quality.csv  Contains one row for each record that has errors. 
4. File  [name]_quality_rel.csv  All of the error messages in relational form. 
5. File  [name]_sort.csv  A copy of the input data after it has been sorted. 
6. File  [name]_summary.csv  A single-row file containing details about the grouping run. 
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